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iRiS Software License Agreement

1. iRiS hereby grants to you a non-transferable (except with iRiS’ permission) license to use the software. YOU DO NOT OWN THE SOFTWARE. iRiS remains the sole owner of the software. The software is a proprietary product of iRiS Software and is protected by international copyright laws and international treaty provisions. 

 2. Your right to use the software is limited to installing the software onto one single computer, or file server, or equivalent. You may make one backup copy provided that iRiS’ copyright notice is copied onto the backup.  

3. Except as permissible by applicable law, you may not: attempt to determine the source code for the software, modify, translate, reprogram, decompile, disassemble, or otherwise reverse engineer the product; sublicense the software to anyone else, or allow anyone to access or execute the software through a time-sharing device. Any attempt to do any of these things will result in immediate termination of your right to the use of this software without prior notice from iRiS.  

4. The software may only be used by the purchaser in the country purchased, and may not be resold, transferred, transshipped, or sublicensed within or outside of that country without express written permission from iRiS Software. In the event of an approved transfer, all copies must be transferred; you may not keep a copy.  

5. iRiS WARRANTS THAT THE SOFTWARE WILL PERFORM FOR A PERIOD OF THIRTY (30) DAYS WITH ITS SPECIFICATIONS. THIS FOREGOING WARRANTY IS VOID IF FAILURE IS DUE TO ACCIDENT, ABUSE, OR MISAPPLICATION. iRiS RESERVES THE RIGHT TO CHOOSE TO (A) REPLACE THE DAMAGED SOFTWARE, (B) REFUND THE PRICE OF THE GOODS. iRiS WILL NOT BE RESPONSIBLE FOR CHANGES IN THE OPERATING CHARACTERISTICS OF COMPUTER HARDWARE OR COMPUTER OPERATING SYSTEMS MADE AFTER THE RELEASE OF THE SOFTWARE NOR  FOR PROBLEMS RESULTING FROM INTERACTION WITH OTHER SOFTWARE.  

6. EXCEPT FOR THE FOREGOING THE SOFTWARE IS PROVIDED "AS IS" AND WITHOUT WARRANTIES.  

7. The license is in effect from the date that you load the software onto your computer and will remain in force until terminated. This agreement is automatically terminated should you breach any of the terms and conditions found within.

Sales Department

iRiS Software

6 Ha'Odem Street

Petach Tikvah, Israel

sales@irisav.com

Service And Support Solutions
iRiS Software is committed to giving you, our customer, the best possible service. We would like to assist you in the use of our software packages, wherever you are located on the globe. That is why iRiS Software has set up easy technical and service support solutions at low or no cost to you.

Service Solutions

How Do I Register My iRiS AntiVirus?
Whether you bought your iRiS AntiVirus package directly from us, or you got it from one of our bundling partners, there is no need to register the software. All software that is found in public circulation is already pre-registered. We at iRiS Software decided to make your lives a little bit easier by pre-registering your software, and allowing you to access our support directly.

Refund Information
For information concerning refunds and eligibility for refunds please contact our sales department at sales@unipress.com.    

iRiS Subscription Service
For information concerning our update subscription service please call (619) 258-9293 or write to support@unipress.com. 

Technical Support Solutions
iRiS offers a wide range of options for those seeking technical support for their iRiS AntiVirus.

World Wide Web Support
The iRiS Web Site (http://www.unipress.com) offers many solutions to user's questions.

· The iRiS Support Center - allows the user to browse through technical support solutions and solve their technical problems on-line.

· The iRiS Support FAQ (Frequently Asked Questions) - lists commonly asked questions, and clear answers, to help the user solve their technical question.

· The iRiS Support Form - submit a form to our technical support desk, stating your specific question, and receive an answer ASAP.

The iRiS Technical Support Line
The iRiS Help Desk is your way to speak to a technical expert about your iRiS AntiVirus software. iRiS believes that the customer deserves the best service at no cost, therefore this service is free. (You are charged for the phone call only) To speak to our service representatives please call 

(732) 287-2100 or (800) 222-0550. 

About Viruses

What is a virus?

A virus is simply a self-replicating program. It is important to distinguish between viruses and "Trojan Horses". A virus is just a program that copies itself; it does not have to be destructive in anyway. A "Trojan Horse" is a deliberately destructive program, but does not replicate. 

There are other programs, such as jokes and droppers, that are not viruses, but many anti-virus programs give the option to the user, if he/she wants to search for these programs. 

 Another important distinction is the one between "bugs" and viruses. Programs occasionally have "bugs" in them. They are only programming errors (though the programmer won’t like admitting to it.) 

What is a typical virus?

There are no typical viruses. Viruses can be categorized into a few different groups: file viruses, boot viruses, multi-partite viruses, stealth viruses, polymorphic viruses, and macro viruses. 

                     File viruses: These viruses attach themselves mostly to executable viruses. Some will replace the normal program’s instructions with its own. This means that when the user opens the file, he/she will see the virus’ display. Other viruses will change the original extension of the file from .COM to .EXE, thereby making the computer load the virus before the actual program.

                     Boot viruses: The boot viruses hook into the boot sectors of a floppy diskette or into the MBR (Master Boot Record) of the hard drive. When the user boots the computer, the virus infects the computer and the code enters the memory. The virus will remain in memory and will infect any floppies that are used. Much as a time bomb is set for explosion at a defined time, usually boot viruses are launched on a specific date or at a specific hour. 

                     Multi-partite viruses: A virus of this sort is a cross of a file virus and a boot virus. They combine the worst of both types of viruses.

                     Macro Viruses: These viruses are the new rising star of viruses. They infect ordinary software files and are not that complicated to write. This means that their numbers will continue to rise as more powerful programs use macros. Although most have no real damaging payload, they are annoying as they can affect the performance of the program. They can be found mainly in Word, but have also targeted Excel and Ami Pro. 

How do they spread?

Viruses can be in a wrapped software product that is loaded onto the computer from a floppy diskette. They can come from purchased hardware. Viruses can be in a downloaded file from the Internet or in an attachment to an e-mail. The most probable way of receiving a virus is on a borrowed diskette from a friend or colleague. 

How do I know that my system is infected?

Much like their physical counterparts, many computer viruses will cause symptoms to appear in the host. Examples of these symptoms are reduced performance, increase in file length, less memory available, and strange screen displays. 

About iRiS AntiVirus
iRiS AntiVirus protects your data in three different ways, that together make up the best data integrity insurance you can get. This is accomplished through the Cure, Active Monitor and Job Manager components of the program. 

iRiS AntiVirus technology can be used on multiple platforms, including Windows 95/98, Windows NT, Windows 3.xx, DOS, Windows CE, Novell NetWare, Macintosh, UNIX (HP and Sun Microsystems), AIX MIPS - NT, Alpha - NT, Power PC - NT, OS/2 

In the next section we will take a look at the components that make up iRiS AntiVirus.

1. Cure - The stand alone scanner

The name cure accurately describes the functions of this component. Cure is a scanner that checks disks and files for any sign of virus activity. Once Cure detects a virus, it identifies it, removes it, and cleans the file so that it is as good as new.

You can customize Cure to conduct operations in a number of different ways. These are explained in depth in the relevant chapters.

Customization Options:

· You can choose which files or drives are scanned

· Different types of removal can be specified

· Infected files can be deleted

· You can determine interactivity and format.

The program is a stand-alone utility that can be used at anytime to check new diskettes or files that are in use on your system and in memory.

Cure reports every phase of its operation so that you know which virus was detected, if the removal was successful, and if the file was successfully reconstructed. Cure also informs you if it thinks a file should be deleted and it can delete it for you. Cure produces a report at the end of the scan that allows you to review its activity.

Cure also scans your system files and checks their integrity. If changes have been made, Cure will alert you and give you solutions to the possible problems.

2. Active Monitor/Immune  -  The Memory Watchman

Active Monitor guards against viral penetration into your computer's memory, since it is the memory resident component of iRiS AntiVirus. The Active Monitor loads automatically, every time the computer is booted, and stays active until the computer is turned off. Whenever a program is run, (either from your hard disk or from a floppy disk) or a file is open, Active Monitor will examine the program code before it is loaded into your system's memory. The Active Monitor will recognize the unique signatures of thousands of viruses, and will stop any known virus before it can become active. 

The Active Monitor remains on guard to protect your system while in Windows 95/98 session and also protects DOS applications under Windows 95/98. The Active Monitor intercepts the reports that the various modules generate when they detect virus activity and generates a Windows pop-up dialogue box that displays a warning that a virus has been discovered and offers an option to remove the virus. 

3. Job Manager  - Scan it when you feel like it.

Job Manager, available also as a stand-alone product, allows you to scan your computer thoroughly, without having to be tied down to the computer. Using its scheduling capabilities you can setup regular scans to insure total protection. Yearly/Monthly/Weekly/Daily/Hourly, you decide what is best for you, and your system.  

Utilizing these complementary components iRiS AntiVirus offers a total anti-virus protection package.

iRiS AntiVirus For Windows 95/98

Installation

What Do You Need To Install iRiS AntiVirus?

iRiS AntiVirus requires the following system configuration:

Hardware: IBM-PC or Compatible

Operating System: Windows 95/98

What Happens During Installation?

In order to use the iRiS AntiVirus package, you need to install the software on your hard-drive. Although this process is quick and straightforward, several important measures are taken during installation to protect your computer.

The setup program thoroughly scans your computer before the iRiS AntiVirus software is installed on your hard-drive. If a virus is found, consult the user manual or the on-line help on the choices available to you. When this process is done, the iRiS AntiVirus software is installed on a totally virus-free computer system.

The setup program copies all files that are necessary to run iRiS AntiVirus into a special sub-directory on your hard-drive. The new sub directory, (called C:\ANTVIRUS by default) will be created automatically, if it does not already exist.

Windows 95/98 - First Time Installation

The iRiS AntiVirus SETUP program makes the installation of iRiS AntiVirus quick and easy. Installation will normally be a one-time process.

To Install iRiS AntiVirus on a computer with a hard-drive:

1. Verify that your write protected original iRiS AntiVirus diskette #1 is in the appropriate drive.

2. In the Windows 95/98 RUN dialogue in the START menu, type:

A:\SETUP  <enter> or B:\SETUP  <enter>

3. Wait for the Installation's opening screen. You can then choose either Next, which will start the installation, or Cancel, which will abort the installation.

4. The iRiS Software License Agreement will then be displayed on the screen. Please read the Agreement and if you agree please press Next. If you do not agree with the License Agreement, please press Cancel. You can also use the Back button to return to the welcome screen.

5. The setup will now request a destination for the iRiS AntiVirus program. The default is C:\Program Files\iRiS\AntiVirus. If you would like to change the default directory please use the Browse button. Your current disk space and disk space after installation are also displayed on this screen. To accept the options on this screen, please press Next. To return to the License Agreement please press Back. To abort the installation, please press Cancel.

6. You will now be asked to choose which components of iRiS AntiVirus you would like to install on your computer. You can install Cure for Windows, AntiVirus Active Monitor, and Job Manager for Windows. By default all three components are checked. To deselect an option please click on the check box next to that component. To accept the checked components please press Next. To return to the Destination screen, please press Back. To abort the installation, please press Cancel.

7. The installation will now ask you which shortcuts you would like to create.  You can choose shortcuts for, Cure for Windows on my Desktop, AntiVirus Active Monitor on my Startup, AntiVirus Active Monitor on my Desktop, Job Manager for Windows on my Startup, and Job Manager for Windows on my Desktop.  To accept your choices please press Next.  To return to the Components page, please press Back.  To abort the setup, please press Cancel.

8. You will now be able to choose the Program Manager group for your  iRiS AntiVirus program.  This will determine the name of the group that the program is located in, in the START|PROGRAM menu. The default is iRiS AV.  To accept please press Next.  To return to the Shortcuts page, please press Back.  To abort the setup, please press Cancel.

9. The Cure for Windows icon will now be located on your desktop and can be used as a shortcut to start an on-demand scan of your hard drive or diskettes. 

Removing iRiS AntiVirus For Windows 95/98

To remove the iRiS AntiVirus Program:

1. Click the Uninstall icon, found in the iRiS AntiVirus group, in the Program menu, under the Start button.

2. Choose OK.

If you receive the "Successfully Uninstalled" message, then iRiS AntiVirus is no longer installed on your hard drive. However, if you receive the "Partially Uninstalled" message, you should try to uninstall again.

3. Please select Boot, to reboot your PC, for the changes to take effect.

Using iRiS AntiVirus For Windows 95/98

Immunization

The Active Monitor protects all applications under Windows 95/98 (including DOS applications). Normal installation of iRiS AntiVirus on your hard drive ensures that the Active Monitor module is activated automatically when the computer is turned on. To manually load the Active Monitor, click on the Active Monitor icon found in either: 

1. The iRiS AntiVirus group, in the Program menu, under the Start button. 

2. The ANTVIRUS folder, in the hard drive.

Virus Detection With The Active Monitor

When a program infected with a virus attempts to load itself into memory, the Active Monitor will be alerted. The Active Monitor will immediately warn you of the attempted infiltration. A dialogue box will pop up on your screen with a message warning of viral infection. This means that the program you are currently running was infected with a virus, which attempted to enter system memory, and the Active Monitor successfully prevented the infected program from running.

What To Do If A Virus Is Found

If you see the Active Monitor warning box appear when you run a particular program, it is likely that the program is infected with a computer virus. The Active Monitor prevents the virus from entering memory and causing damage, you have three choices: Ignore, Cure, and Delete. 

Configuring Active Monitor

The Active Monitor is found in the tray on the right side of the task bar. Clicking on the icon will maximize the screen and show the options available. The options are: Update (which bring you through the update procedure), Properties (that allow you to change the Action and Detection modes of the Active Monitor), and Terminate (which shuts the Active Monitor down). Inside the Help menu you will find the About screen, that contains information about the version number of your copy of iRiS AntiVirus, and the Customer Help screen, which holds contact information for iRiS Software. The Active Monitor also allows you to choose between ENABLE and DISABLE modes, by clicking on the button at the bottom of the screen. To return the Active Monitor to the taskbar, minimize the window.

Curing Your System

The Cure component detects viruses, removes them from your files, and reconstructs the damaged files. Double click on the Cure for Windows 95/98 icon and scan your disk or diskettes for viruses. The Cure icon is found either: 

1. On your desktop.

2. The iRiS AntiVirus group, in the Program menu, found under the Start button.

3. The ANTVIRUS directory, found in the hard drive.  

Using Cure For Windows 95/98
After opening the Cure component, it is now time to configure it to run the way you want and need it to. The following options are available to you:

· New Scan - allows you to open scanning specifications, with the default values. 

· Virus List - allows you to view and search through, the list of viruses that iRiS AntiVirus handles. It also provides in-depth information on these viruses.

· Internet - will open your web browser and bring you to the iRiS Web Site and allow you to browse through iRiS' vast virus resources.

· Scheduler - allows you to regularly schedule scans to insure top level protection.

· Options - includes:

· Virus - allows you to choose what the program does when it finds a virus.
· Scan - lets you decide what kind of files are scanned.
· Logs - gives you the opportunity to create a log of the scan, and lets you print it out as well.
· Detection - lets you decide how iRiS AntiVirus will scan your files and drives.
· Templates - allows you to include or exclude file types in the scan. 
· Alarms - lets you control the programs message or sound output whenever a virus is found.
· Other - allows you to set the update reminder counter and date format.

· Help - offers informative answers to your questions.

· Scan Now - starts the detection process.

· Save Scan List - allows you to save the specific scanning perameters. 

· Exit - closes the program.

To choose a drive to be scanned click on the box next to the drive name. To view the contents of the drive and pick directories and files to be scanned, double click on the arrow next to the drive. If all of the directories and files in a drive are selected then the box next to the drive will be completely filled in blue. If only some of the directories and files are selected then the box will be partially filled in blue. If no directories or files are selected (the drive is not included in the scan), then the box will be white. The same holds true for all directories, sub-directories and files.      

Customizing Cure For Windows 95/98

As described above, there are many customizable options available to you. These can be found in the Options menu of the Cure component. This section will describe these options and what they can do for you.

Virus:

· Automatic virus handling - Controls what Cure will do when it finds a virus. 
· Cannot handle virus - If Cure cannot automatically handle the virus, you can choose what action it will take next.
· Copy Sample - If you would like to make a copy of the infected object for later investigation, Cure can do it for you.

Scan:

· Objects to scan - Determines what Cure scans.

· Files to scan - What file types Cure will scan.

· Scanning mode - Choose what type of scan Cure should run.


Logs:

· Generate reports - Controls if Cure should create a log, and if so, what kind of log it will be.  
· Generate the report file to - If a log file is created, this specifies the name of the file and the directory where it is located.
· What to report - Determines what is included in the log that is generated at the end of the scan.

Detection:

· Scan also for - Allows the you to choose if you want to scan for objects that are not viruses, but could be affecting your computer in a negative way.

· Rigorous scanning - Determines how thoroughly the objects are scanned

· Memory scan - Decide which memory blocks should be scanned.

· Special scanning - Turn the heuristic scan (detects viruses based on behavior, rather than a predetermined signature file) feature on or off.


Templates:

· Exclusions - Specific file types to be excluded from the scan.
· Inclusions - Specific file types to be included in the scan.

Alarm:

· A virus was found - Controls Cure's reaction when a virus is detected.

Other:

· AntiVirus outdated - Allows you to choose the timing for an "out-of-date" message to appear, to remind you to update your copy of iRiS AntiVirus.
· Date format - Choose the date format that fits with your computer, for the "out-of-date" message.
· Time format - Choose the time format that fits with your computer, for the "out-of-date" message.
By choosing which options best fit you and your needs, you can configure Cure to protect your specific system and your specific needs.

When To Use Cure For Windows 95/98

You can use the Cure for Windows component any time you want, to ensure that a specific diskette or hard drive partition is virus free. We recommend that you run Cure for Windows periodically (once a week), as well as whenever you obtain new software or add new files to your hard drive. Periodical scans can be automatically scheduled by using the Job Manager. You should always run Cure for Windows after the Active Monitor has detected a viral infection.

Using the Job Manager

To schedule a scan with the Job Manager, you must first create a scanner list. To do so please choose the options you want iRiS AntiVirus to run with, then press the Save scan list button found in the Cure for Windows component. You can then open the Job Manager by clicking on the Scheduler button in the Cure for Windows component.

You must then choose to add a scan job and then choose a scanner list to load, with your preset operating specifications. Once this is done you can set the Frequency (how often the scan is run), Start Date (the date that you would like the scan to start operating), Start Time (the exact time you would like the scan to start operating), Mode Job (the type of action being scheduled), and Mode Run (the behavior of the scheduled scan during operation). Once all the information is entered you must save the information by pressing the Save button. 

You have now scheduled a scan of your computer, with your preset parameters.  The computer must be on, and the Job Manager must be enabled at the time of the scheduled scan. 

If Cure For Windows 95/98 Can't Clean The File

If it is not possible to remove a virus from a file, you have the option to save a sample of the infected file for further investigation. Once a sample has been saved, please send a copy of it to our virus lab. Via e-mail, please send the virus to support@unipress.com. Via snail mail, please send a diskette with the virus on it to: 


Infected


c/o iRiS Software


1173a 2nd Ave.


Suite 316


New York, New York


USA

Updating Your iRiS AntiVirus Protection Package

With the ever increasing number of computer viruses that are released into public circulation everyday, regular updates of your iRiS AntiVirus, is more important that anything. One of the most common reasons for a viral infection is out of date anti-virus software. 

Where To Get An Update For Your iRiS AntiVirus

There are four options available to update your software package:

1. The iRiS Web Site

2. Automatic download from a 1-900 number

3. Download from CompuServe

4. The iRiS Help Desk

The iRiS Web Site

Downloads are available from the iRiS Web Site www.unipress.com, from the shop page. You can also go to the Web Site directly through the Active Monitor. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the right hand side of the taskbar.). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose Internet. After writing down your serial number, choose ok. Choose the link to update your iRiS AntiVirus to the latest version and fill out the order form. Then click on the Order button. The update file will then begin to download into your computer. Once the update file has been downloaded it has to be run. The file is a self-extracting zip file, so other files will be extracted from it after it is run. One of these files is a Setup32.exe file. This file will overwrite your old virus data file with a new one. After this file is run the upgrade is complete, and you can continue to feel safe and virus free.

Automatic Download From A 1-900 Number (Available in USA ONLY)

Downloads of the virus data file are available for download via modem through a 1-900 number service. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the right hand side of the taskbar.). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose Line 900. Then choose Continue after reading the billing agreement. The files for the update will then be downloaded and installed directly into your iRiS AntiVirus program. 
Download From CompuServe
For members of CompuServe, downloads of the virus data file are available for download via modem, through a CompuServe service. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the right hand side of the taskbar.). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose CompuServe. After writing down your serial number choose ok. The files for the update will then be downloaded and installed directly into your iRiS AntiVirus program. 

The iRiS Help Desk
By contacting the iRiS Help Desk you can order updates delivered to your e-mail or snail mail address. To contact the Help Desk, please call (732) 287-2100 or (800) 222-0550.   

Using Cure For Windows 95/98 With Command Line Switches

The CURE module can also be run non-interactively. This is useful if you want to include CURE in a batch file. To run CURE in this manner, you must specify command line switches.

 The CURE COMMAND LINE syntax is as follows:

    Cure [drive: \<directory\filename>  /<options>]

Command Line Options:

/? or /h 
Display the HELP screen.

/C
Cure infected files

/D
Delete infected files

/H
Scan all high memory

/L<:xxx>
Display viruses <virus information>

/M
Do not scan memory for viruses

/N <:directory>
Rename infected files or move to directory

/O
Inform only (take no action, quiet mode)

/Q
Quiet Mode

/R<:x>
Generate report (default = infected files only, 1= all files scanned, 2= clean files only)

/P<:LPTx>
Send the report to a printer (default = PRN, LPTx = LPT number)

/S
Very slow scan (scans files thoroughly)

/B
Scan boot/Master Boot Record (MBR) only

/E
Include heuristics

/F:xxx
Scan from list file

/G
Ignore errors

/Y
Scan multiple diskettes
For example:

CURE D:\DOS  /S /E

Scan files in the DOS directory on drive D, in a slow scan, using heuristics.

iRiS AntiVirus For DOS

Installation

What Do You Need To Install iRiS AntiVirus?

iRiS AntiVirus requires the following system configuration:

Hardware: IBM-PC or Compatible

Operating System: DOS 

What Happens During Installation?

In order to use the iRiS AntiVirus package, you need to install the software on your hard-drive. Although this process is quick and straightforward, several important measures are taken during installation to protect your computer.

The setup program thoroughly scans your computer before the iRiS AntiVirus software is installed on your hard-drive. If a virus is found, consult the on-line help on the choices available to you. When this process is done, the iRiS AntiVirus software is installed on a totally virus-free computer system.

The setup program copies all files that are necessary to run iRiS AntiVirus into a special sub-directory on your hard-drive. The new sub directory, (called ANTVIRUS by default), will be created automatically, if it does not already exist.

DOS - First Time Installation

The iRiS AntiVirus SETUP program makes the installation of iRiS AntiVirus quick and easy. Installation will normally be a one-time process.

To Install Iris AntiVirus on a computer with a hard drive:

1. Verify that your original write protected iRiS AntiVirus diskette # 1is in the appropriate drive.

2. At the DOS prompt type:

A:\SETUP  <enter> or B:\SETUP  <enter>

3. The SETUP program will then ask you if you would like to continue installing iRiS AntiVirus on your computer. You can choose Yes [Y], or No [N].

4. The SETUP program will then load, check the integrity of the system, scan your disk for viruses, and copy the files necessary to run iRiS AntiVirus onto your computer. 

5. If the SETUP program completed the installation successfully you will receive the "Finished Copying, Done!" message. If you do not receive this message you might have to reinstall iRiS AntiVirus.

Setup Options

If you would like to configure the way the SETUP program runs, there are a few options available. The Setup Command Line syntax is as follows:

SETUP  /<options> <enter>

Options:

/?
Display the HELP screen
/D
Do not scan before installation

/B
Reboot computer after installation (recommended)

/WIN
Run the command line setup for Windows

/PATH=
Designate the directory to install to (ANTVIRUS is the default)

Removing Iris AntiVirus For DOS

To remove the iRiS AntiVirus Program from DOS:

1. Delete the ANTVIRUS (or the directory where the iRiS AntiVirus files are found) directory and all of the files within. This can be done with the DELTREE command from the c: prompt. 

2. If you have made no changes to your system since installing iRiS AntiVirus, then simply replace the current AUTOEXEC.BAT with the AUTOEXEC.AV file that was created when you first installed iRiS AntiVirus. This can be done by renaming the AUTOEXEC.AV file AUTOEXEC.BAT. If you have made changes to your system, then you will manually have to erase the references to iRiS AntiVirus from your AUTOEXEC.BAT file. The lines that have to be erased are: 

REM *** iRiS AntiVirus ***

SET ANTVIRUS=C:\ANTVIRUS

COMMAND /CC:\ANTVIRUS\EXAMINE

C:\ANTVIRUS\IMMUNE /NOP /N

REM *** iRiS AntiVirus ***

In the SET PATH line please delete the words C:\ANTVIRUS
3. Once this has been completed please reboot the computer for the changes to take effect.

Using Iris AntiVirus
Loading Immune 

Normal installation of iRiS AntiVirus on your hard disk ensures that the Immune module is activated automatically when your computer is turned on. However, if you completed an installation and did not update Immune in your AUTOEXEC.BAT file, you will need to manually load the module into the memory. To manually load the Immune module:

1. Make sure that the active drive is correct, and that the current directory contains the iRiS AntiVirus files (C:\ANTVIRUS is the default).

2. Load the module by typing:

IMMUNE<enter>

Customizing Immune

The Immune component of the iRiS AntiVirus program can be customized to run to best suit your system.  

The Immune Command Line syntax is as follows:

IMMUNE  /<options> <enter>

Note: Either / or - can be used to control the command line switches.

Options:

/H
Displays help and status screen

/N
Do not scan memory for viruses

/U
Unload Immune from memory

/ALL
Scan all files for viruses (not just executable files)

/DIS
Disable Immune without unloading it

/ENA
Enable Immune (if disabled)

/LC
Load large Immune in conventional memory

/LE
Load large Immune in expanded memory

/LX
Load large Immune in extended memory

/M
Load medium Immune

/NFS
Do not use fast scan for scanning files
/NOP
Do not scan open files for viruses

/NT
Return error level if Immune is not loaded

/NTC
Update iRiS AntiVirus if out of date

/NTL
Return error level if large Immune is not loaded

/XHK
Do not rehook interrupt 21 for NetWare

/PR
Monitor workstation for virus-like behavior (Prevent)

/XNT
Disable virus message broadcast  

/Q
Do not display installation messages (quiet)

/S
Load small Immune

/1
Scan 1M of memory

If you would like Immune to load on start up with any of these options please add the command line switch for the option you would like to add to the C:\ANTVIRUS\IMMUNE /NOP /N line in the iRiS AntiVirus section of the AUTOEXEC.BAT file. 

Virus Detection With Immune 

If a virus attempts to enter your computer system's memory, the Immune module will be alerted. Immune will immediately notify you of the attempted infiltration by putting a dialogue box on your screen that warns you of viral infection. If the program that you are attempting to run is infected with the virus Immune will help you prevent viral infiltration of the computer system's memory by denying access to the program.

What To Do If A Virus Is Found

If you see the Immune warning box appear when you run a particular program, it is more than likely that the program is infected with a computer virus. Although Immune prevents the virus from entering your computer's memory and causing damage, it cannot remove the virus from the infected diskette or disk. To eradicate the viral code from the infected diskette or disk, you need to run CURE on the infected medium.

Using Examine
Examine is a system integrity monitor, that checks any changes in the system files. While the Examine component is incorporated into the startup of the Cure module in the Windows 3.x and Windows 95/98 product, it is a separate component in the DOS version. With a normal installation Examine is run on startup. If you would like to run Examine manually please type:

EXAMINE <enter>

Configuring Examine
The Examine component of the iRiS AntiVirus program can be customized to run to best suit your system.  

The Examine Command Line syntax is as follows:

EXAMINE  /<options> <enter>

Options:

/?
Display the HELP screen

/C
Create new signature files (if changes have intentionally been made to system files)

/A
Accept all changes found

/R
Restore changes to original state

/I
Ignore changes

/1
Check upper memory area

/N
Do not check memory 

/S
Do not check the CMOS setup

/Q
Quiet mode

If you would like any of these features in the Examine component to run on startup, please add the command line switch to the line COMMAND /CC:\ANTVIRUS\EXAMINE in the iRiS AntiVirus section of the AUTOEXEC.BAT.

Running CURE For DOS

The CURE module detects viruses, removes them from your files, and reconstructs the damaged files.

When To Use CURE For DOS

You can use the CURE program any time you want to, to ensure that a specific diskette or hard drive partition is virus free. We recommend that you run CURE whenever you obtain new software, or add new files to your hard drive. You should always run CURE after Immune has detected a viral infection.

Starting CURE

1. Make sure the current directory contains the iRiS AntiVirus software. (The default directory is ANTVIRUS)

2. Run the CURE module by typing:

CURE <enter>

The CURE COMMAND LINE syntax is as follows:

    Cure [drive: \<directory\filename>  /<options>]

Command Line Options:

/? or /H 
Display the HELP screen.

/C
Cure infected files

/D
Delete infected files

/H
Scan all high memory

/L<:xxx>
Display viruses <virus information>

/M
Do not scan memory for viruses

/N <:directory>
Rename infected files or move to directory

/O
Inform only (take no action, quiet mode)

/Q
Quiet Mode

/R<:x>
Generate report (default = infected files only, 1= all files scanned, 2= clean files only)

/P<:LPTx>
Send the report to a printer (default = PRN, LPTx = LPT number)

/S
Very slow scan (scans files thoroughly)

/B
Scan boot/Master Boot Record (MBR) only

/E
Include heuristics

/F:xxx
Scan from list file

/G
Ignore errors

/Y
Scan multiple diskettes
For example:

CURE D:\DOS  /S /E

Scan files in the DOS directory on drive D, in a slow scan, using heuristics.

If Cure For DOS Can't Clean The File

If it is not possible to remove a virus from a file, you can send iRiS Software a copy of the "infected file." Please send a copy of it to our virus lab. Via e-mail, please send the virus to support@unipress.com. Via snail mail, please send a diskette with the virus on it to: 


Infected


c/o iRiS Software


1173a 2nd Ave.


Suite 316


New York, New York


USA

Updating Your iRiS AntiVirus Protection Package

With the ever increasing number of computer viruses that are released into public circulation everyday, regular updates of your iRiS AntiVirus, is more important that anything. One of the most common reasons for a viral infection is out of date anti-virus software. 

Where To Get An Update For Your iRiS AntiVirus

There are two options available to update your software package:

1. The iRiS Web Site

2. The iRiS Help Desk

The iRiS Web Site

Downloads are available from the iRiS Web Site www.unipress.com/iris, from the shop page. Choose the link to update your iRiS AntiVirus to the latest version and fill out the order form. Then click on the Order button. The update file will then begin to download into your computer. Once the update file has been downloaded it has to be run. The file is a self-extracting zip file, so other files will be extracted from it after it is run. One of these files is a Setup.exe file. This file will overwrite your old virus data file with a new one. After this file is run the upgrade is complete, and you can continue to feel safe and virus free.

The iRiS Help Desk
By contacting the iRiS Help Desk you can order updates delivered to your e-mail or snail mail address. To contact the Help Desk, please call (732) 287-2100 or (800) 222-0550.

iRiS AntiVirus For Windows 3.x

Installation

What Do You Need To Install iRiS AntiVirus?

iRiS AntiVirus requires the following system configuration:

Hardware: IBM-PC or Compatible

Operating System: Windows 3.1 or higher

What Happens During Installation?

In order to use the iRiS AntiVirus package, you need to install the software on your hard-drive. Although this process is quick and straightforward, several important measures are taken during installation to protect your computer.

The setup program thoroughly scans your computer before the iRiS AntiVirus software is installed on your hard-drive. If a virus is found, consult the user manual or the on-line help on the choices available to you. When this process is done, the iRiS AntiVirus software is installed on a totally virus-free computer system.

The setup program copies all files that are necessary to run iRiS AntiVirus into a special sub-directory on your hard-drive. The new sub directory, (which is called ANTVIRUS by default), will be created automatically, if it does not already exist.

Windows 3.x  - First Time Installation

The iRiS AntiVirus SETUP program makes the installation of iRiS AntiVirus quick and easy. Installation will normally be a one-time process.

To Install iRiS AntiVirus on a computer with a hard-drive:

1. Verify that your write protected original iRiS AntiVirus diskette #1 is in the appropriate drive.

2. In the Windows RUN dialogue in the File menu, type:

A:\SETUP <enter> or B:\SETUP <enter>

3. Wait for the Installation's opening screen.

4. Choose Install iRiS AntiVirus from the menu. The other options are Help and Exit. Once you have chosen Install, a series of dialogues will guide you through the installation process. You will have some options: 

· Client - installs full copy of iRiS AntiVirus, the scanner and Active Monitor

· Secondary Client - installs the scanner only. Good for computers running more than one anti-virus program, since two memory resident monitors may cause conflicts on your system.

· Server - installs iRiS AntiVirus on a network drive. Will not install an iRiS program group in the Start menu.

· Custom - enables you to define parameters that control the way the SETUP program and the iRiS AntiVirus itself function. The options are:

· Type - choose between a full client, a secondary client, and server installation. 

· Immune - lets you decide which options of the Active Monitor you want to load on startup.

· Message- allows you to customize iRiS AntiVirus' warning message for when a virus is found. 

· Batch - Add iRiS AntiVirus to your AUTOEXEC.BAT, or save the commands in a separate file. 

5. Specify the drive and sub-directory on which you would like to install iRiS AntiVirus (C:\ANTVIRUS is the default).

6. SETUP will now scan your hard drive for viruses, and if none are found it will copy the iRiS AntiVirus files onto your hard drive.

7. SETUP will now check with you before modifying your hard drive's AUTOEXEC.BAT file. If no AUTOEXEC.BAT file exists on the current drive, SETUP will create a new file for you. iRiS AntiVirus will insert commands into the AUTOEXEC.BAT file so that your computer activates the Active Monitor module every time you boot up. 

NOTE:  If you choose not to update your AUTOEXEC.BAT, you will have to manually load the iRiS AntiVirus memory-resident modules to enjoy the full benefits of the iRiS AntiVirus package.

8. Choose to have the Active Monitor load automatically (the default setting), or manually. Choosing automatic causes the Active Monitor to load whenever Windows is loaded. Choosing manual gives you the ability to load the Active Monitor when you want to. 

9. If the Installation was completed successfully, you will receive the "Installation Successful" message. If you receive a "Partially Successful" message, you may have to reinstall iRiS AntiVirus.

10. Select Boot from the main menu to finish the SETUP program, and load the Active Monitor, if you chose to have the Active Monitor load automatically. You can also choose Exit (to exit the install program), View (to view the ReadMe file), or Help (to find out more information). 
Special Instructions For Network Installation

 Server Installation

The Server Installation will be fully capacitated provided that you are, or authorized by, a Network Administrator. Then, if you wish to install iRiS AntiVirus on the Server, you may do so by selecting Server on the Installation Type Selection dialog window. Then the dialog asking you to enter the target directory name, (C:\Antvirus by default), will appear. The Setup program will check with you before modifying your network login script file.

NOTE: Unlike a private installation, the server setup will not modify the server's AUTOEXEC file and it won't create any signature file either. 

Network Stations With A Hard Drive

You cannot install iRiS AntiVirus unless you are - or are authorized by a Network Administrator. Select the option Station if you are a part of a network and you want to install iRiS AntiVirus from the server.

To run the Setup program from the server, write in the File Menu - Run dialog:

[AntiVirus path name on the server]\Setup

The Setup program will be loaded first, and the source directory, which is the directory to which the iRiS AntiVirus has been installed to the server will be scanned for viruses. The installation procedure is the same as in installing a full copy.

The dialog asking you to enter the target directory name, (C:\Antvirus by default), will appear.

Your AUTOEXEC.BAT will be updated to include the AntiVirus path name of the server. This will enable you to update iRiS AntiVirus from the server. The Immune module will be installed on your hard disk, and your AUTOEXEC.BAT will be updated as in the client installation option, so that Immune will be loaded every time your computer boots.

Removing Iris AntiVirus For Windows 3.x
To remove the iRiS AntiVirus Program:

1. Click the Uninstall icon, found in the iRiS AntiVirus program group.

2. Choose OK.

If you receive the "Successfully Uninstalled" message, then iRiS AntiVirus is no longer installed on your hard drive. However, if you receive the "Partially Uninstalled" message, you should try to uninstall again.

3. Please select Boot, to reboot your PC, for the changes to take effect.

Using Iris AntiVirus
Loading The Active Monitor
Normal installation of iRiS AntiVirus on your hard disk ensures that the Active Monitor module is activated automatically when your computer is turned on.

However, if you completed a custom or private installation and did not update the Active Monitor in your AUTOEXEC.BAT file, you will need to manually load the module into the memory. To manually load the Active Monitor module:

Double click the Active Monitor's icon to activate it manually. The icon for the Active Monitor can be found inside the iRiS AntiVirus program group. 

Virus Detection With  The Active Monitor 

If a virus attempts to enter your computer system's memory, the Active Monitor module will be alerted. The Active Monitor will immediately notify you of the attempted infiltration by putting a dialogue box on your screen that warns you of viral infection. If the program that you are attempting to run is infected with the virus, the Active Monitor helps you prevent viral infiltration of your computer system's memory by denying access to the program.

What To Do If A Virus Is Found

If you see the Active Monitor warning box appear when you run a particular program, it is more than likely that the program is infected with a computer virus. Although the Active Monitor prevents the virus from entering your computer's memory and causing damage, it cannot remove the virus from the infected diskette or disk. To eradicate the viral code from the infected diskette or disk, you need to run CURE on the infected medium.

Configuring Active Monitor

The Active Monitor is found as an icon on your desktop. Clicking on the icon will maximize the screen and show the options available. The options are: Update (which bring you through the update procedure), Properties (that allow you to change the Action and Detection modes of the Active Monitor), and Terminate (which shuts the Active Monitor down). Inside the Help menu you will find the About screen, that contains information about the version number of your copy of iRiS AntiVirus. The Active Monitor also allows you to choose between ENABLE and DISABLE modes, by clicking on the button at the bottom of the screen. To return the Active Monitor to the desktop, minimize the window.

Curing Your System

The Cure component detects viruses, removes them from your files, and reconstructs the damaged files. Double click on the Cure for Windows icon and scan your disk or diskettes for viruses. The Cure icon is found in the iRiS AntiVirus directory, found on the desktop.  

Using Cure For Windows 3.x
After opening the Cure component, it is now time to configure it to run the way you want and need it to. The following options are available to you:

· New Scan - allows you to open scanning specifications, with the default values. 

· Virus List - allows you to view and search through, the list of viruses that iRiS AntiVirus handles. It also provides in-depth information on these viruses.

· Internet - will open your web browser and bring you to the iRiS Web Site and allow you to browse through iRiS' vast virus resources and get program updates.

· Options - includes:

· Virus - allows you to choose what the program does when it finds a virus.
· Scan - lets you decide what kind of files are scanned.
· Logs - gives you the opportunity to create a log of the scan, and lets you print it out as well.
· Detection - lets you decide how iRiS AntiVirus will scan your files and drives.
· Templates - allows you to include or exclude file types in the scan. 
· Alarms - lets you control the programs message or sound output whenever a virus is found.
· Other - allows you to set the update reminder counter and date format.

· Help - offers informative answers to your questions.

· Scan Now - starts the detection process.

· Save Scan List - allows you to save the specific scanning parameters. 

· Exit - closes the program.

To choose a drive to be scanned click on the box next to the drive name. To view the contents of the drive and pick directories and files to be scanned, double click on the arrow next to the drive. If all of the directories and files in a drive are selected then the box next to the drive will be completely filled in blue. If only some of the directories and files are selected then the box will be partially filled in blue. If no directories or files are selected (the drive is not included in the scan), then the box will be white. The same holds true for all directories, sub-directories and files.      

Customizing Cure For Windows 3.x

As described above, there are many customizable options available to you. These can be found in the Options menu of the Cure component. This section will describe these options and what they can do for you.

Virus:

· Automatic virus handling - Controls what Cure will do when it finds a virus. 
· Cannot handle virus - If Cure cannot automatically handle the virus, you can choose what action it will take next.
· Copy Sample - If you would like to make a copy of the infected object for later investigation, Cure can do it for you.

Scan:

· Objects to scan - Determines what Cure scans.

· Files to scan - What file types Cure will scan.

· Scanning mode - Choose what type of scan Cure should run.


Logs:

· Generate reports - Controls if Cure should create a log, and if so, what kind of log it will be.  
· Generate the report file to - If a log file is created, this specifies the name of the file and the directory where it is located.
· What to report - Determines what is included in the log that is generated at the end of the scan.

Detection:

· Scan also for - Allows the you to choose if you want to scan for objects that are not viruses, but could be affecting your computer in a negative way.

· Rigorous scanning - Determines how thoroughly the objects are scanned

· Memory scan - Decide which memory blocks should be scanned.

· Special scanning - Turn the heuristic scan (detects viruses based on behavior, rather than a predetermined signature file) feature on or off.


Templates:

· Exclusions - Specific file types to be excluded from the scan.
· Inclusions - Specific file types to be included in the scan.

Alarm:

· A virus was found - Controls Cure's reaction when a virus is detected.
· Network - Define if you want other users on the network to be notified of a virus infection.

Other:

· AntiVirus outdated - Allows you to choose the timing for an "out-of-date" message to appear, to remind you to update your copy of iRiS AntiVirus.
· Date format - Choose the date format that fits with your computer, for the "out-of-date" message.
· Time format - Choose the time format that fits with your computer, for the "out-of-date" message.
By choosing which options best fit you and your needs, you can configure Cure to protect your specific system and your specific needs.

When To Use CURE For Windows 3.x

You can use the CURE program any time you want, to ensure that a specific diskette or hard drive partition is virus free. We recommend that you run CURE whenever you obtain new software, or add new files to your hard drive. You should always run CURE after the Active Monitor has detected a viral infection.

If Cure For Windows 3.x Can't Clean The File

If it is not possible to remove a virus from a file, you should save a sample of the infected file for further investigation. Once a sample has been saved, please send a copy of it to our virus lab. Via e-mail, please send the virus to support@unipress.com. Via ground mail please send a diskette with the virus on it to: 

Infected


c/o iRiS Software


1173a 2nd Ave.


Suite 316


New York, New York


USA

Updating Your iRiS AntiVirus Protection Package

With the ever increasing number of computer viruses that are released into public circulation everyday, regular updates of your iRiS AntiVirus, is more important that anything. One of the most common reasons for a viral infection is out of date anti-virus software. 

Where To Get An Update For Your iRiS AntiVirus

There are four options available to update your software package:

1. The iRiS Web Site

2. Automatic download from a 1-900 number

3. Download from CompuServe

4. The iRiS Help Desk

The iRiS Web Site

Downloads are available from the iRiS Web Site www.unipress.com, from the shop page. You can also go to the Web Site directly through the Active Monitor. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the desktop.). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose Internet. After writing down your serial number, choose ok. Choose the link to update your iRiS AntiVirus to the latest version and fill out the order form. Then click on the Order button. The update file will then begin to download into your computer. Once the update file has been downloaded it has to be run. The file is a self-extracting zip file, so other files will be extracted from it after it is run. One of these files is a Setup.exe file. This file will overwrite your old virus data file with a new one. After this file is run the upgrade is complete, and you can continue to feel safe and virus free.

Automatic Download From A 1-900 Number (Available in USA ONLY)

Downloads of the virus data file are available for download via modem through a 1-900 number service. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the desktop). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose Line 900. Then choose Continue after reading the billing agreement. The files for the update will then be downloaded and installed directly into your iRiS AntiVirus program. 
Download From CompuServe
For members of CompuServe, downloads of the virus data file are available for download via modem, through a CompuServe service. To activate this service, you have to open the Active Monitor (To open the Active Monitor, double click on the Magnifying Glass, on the right hand side of the taskbar.). Once the Active Monitor is open choose Update, found in the Options menu. Then choose the appropriate flag for the country that you are in. Then choose CompuServe. After writing down your serial number choose ok. The files for the update will then be downloaded and installed directly into your iRiS AntiVirus program. 

The iRiS Help Desk
By contacting the iRiS Help Desk you can order updates delivered to your e-mail or snail mail address. To contact the Help Desk, please call (732) 287-2100 or (800) 222-0550.

Using CURE For Windows 3.x With Command Line Arguments In DOS

The CURE module can also be run non-interactively. This is useful if you want to include CURE in a batch file. To run CURE in this manner, you must specify command line switches.

 The CURE COMMAND LINE syntax is as follows:

    Cure [drive: \<directory\filename>  /<options>]

Command Line Options:

/? or /h 
Display the HELP screen.

/C
Cure infected files

/D
Delete infected files

/H
Scan all high memory

/L<:xxx>
Display viruses <virus information>

/M
Do not scan memory for viruses

/N <:directory>
Rename infected files or move to directory

/O
Inform only (take no action, quiet mode)

/Q
Quiet Mode

/R<:x>
Generate report (default = infected files only, 1= all files scanned, 2= clean files only)

/P<:LPTx>
Send the report to a printer (default = PRN, LPTx = LPT number)

/S
Very slow scan (scans files thoroughly)

/B
Scan boot/Master Boot Record (MBR) only

/E
Include heuristics

/F:xxx
Scan from list file

/G
Ignore errors

/Y
Scan multiple diskettes
For example:

CURE D:\DOS  /S /E

Scan files in the DOS directory on drive D, in a slow scan, using heuristics. 

About iRiS Software

Background

iRiS Software was established in 1979, by Ofer Achitoov, and concentrates on anti-virus technology, PC security, and utility software. iRiS Software, based in Israel, was the first company in the world to produce an anti-virus solution in 1987.

iRiS Software continues to develop cutting-edge anti-virus technology through constant innovative research. iRiS Software foresaw the virus threat and has met the challenge head on at every level. AntiVirus was iRiS' first virus protection creation, an incredible virus detector and cleaner that works on all platforms and operating systems. Following that success iRiS released AntiVirus LITE, the smallest anti-virus program on the market. LITE is the perfect solution when disk space or downloading time is a problem. Finally, with the release of Windows CE, iRiS once again met the consumers needs, and released AntiVirus CAT (Compact AntiVirus Technology), the first anti-virus protection software for the Handheld PC.     

iRiS Software also realized that its customers needed more than just anti-virus software, and so iRiS developed its line of PC security and utility software. The iRiSentinel protects the computer's hard drive from harmful activity that could cause the user hours of frustration and endless gigabytes of lost work. iRiSentinel not only protects but also restores valuable system files to the disk, so users can be confident that their data is safe. The iRiS Job Manager is a clever stand-alone utility that allows users to schedule programs to run at any time with parameters that they set.   

WorldWide Clients
Overseas, iRiS Software has licensing agreements with a number of companies. iRiS Software distributes its products under the private labels of the following companies: 

· Computer Associates

· Broderbünd

The anti-virus software is sold by these companies under the following respective names: InocuLAN and ViruCide. 

In addition, iRiS Software is also offered under the name iRiS AntiVirus through bundling agreements or offers of download from the Internet. The companies offering the software include: 

· USRobotics ( a division of 3COM)

· America-On-Line

· Packard-Bell 

· Dell

· Hitachi

iRiS AntiVirus technology is used for internal purposes in large companies worldwide, such as Compaq and Microsoft.
In Israel, iRiS Software holds large accounts in both the public and private sectors. Here are just a few of the large clients in the private industry: 

· Coca-Cola

· Motorola

· IBM

· Digital

· Hewlett-Packard 

The public accounts include:

· Israeli Defense Forces

· Israel Aircraft Industries

· Israeli Postal Authority

· Ministries of Foreign Affairs and Education

· Bezek Telecommunications
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